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Introduction

You purchased Bluespring Software’s BPMs, an innovative version of Business Process Management

(BPM) software which will allow your company to effectively reduce cost, increase customer

responsiveness, ensure quality, maintain compliance, and manage growth with proven success.

Bluespring Software has acted as a supplement to an array of companies’ business processes since 1998.

This guide will lead you through the installation of the BPM;. If you have questions about the

installation, please contact Bluespring Support by email at support@bluespringsoftware.com or by
phone at (877) 871-9566.

The following services and applications will be installed upon the completion of the steps in this guide:

BPM Workspace Service

BPM Task Service

BPM Notification Service

BPM Scheduling Service

BPM Process Engine Service

BPM File Monitor Service (optional)
BPM SharePoint Service (optional)
BPM CRM Service (optional)

BPM Designer 5

BPM Admin 5

BPM; Capabilities

You can use BPM5 to perform a series of automated and managed tasks as part of your business

processes. Key capabilities include:

Collaborative definition and deployment of process solutions that span any combination of
people, systems, data sources, locations, and organizational entities.

Improved utilization of Microsoft investment (SharePoint, Dynamics, Exchange, etc).
Ability for you to control your existing IT assets, including systems, data sources, and
documents within any business process through standards-based integration methods.
Management of steps that require human interaction for the completion of a task.
Operation as a non-intrusive service within your existing infrastructure to drive highly
consistent, reliable, scalable, and dynamic automated processes.

Presentation of tools which will allow you to effectively monitor and manage the operating
process on a real-time basis.

Ability to report in real-time how a business process is performing and make decisions that
positively impact your bottom line.
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BPM; Architecture

Workspace
* General configuration
* Unpublished
solutions

XZ/J Workspace Service

BPM Designer
@i Notification Service Notification Service
. )/ ¢ o >
BPM Admin Scheduling Service Scheduling Service

Task Service Task Service

Process Engine Process Engine

Internet ﬂ Manual Internet
Activities ‘ Activities Activities

© 3 Automated Database Automated Database
© 5 Activities Activities © 5 Activities Activities

Runtime (1) Runtime(2)
+Publishadsolations sPublishzd solutions
sRuntim2 state / data sRuntims stats / data

BPM; will run against on Workspace which supports multiple run-time environments.

The number of run-time environments you create will support your process development lifecycle.
Development lifecycles may vary and BPM; is designed to support agile and waterfall approaches to
process development.
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Hardware and Software Requirements

Verify that the server(s) you have designated for Bluespring BPM; meet the following hardware and
software requirements.

Hardware Software

O 32-bit or 64-bit 0 Services require one of the following:

O CPU > 2.2 GHz (Dual or Quad Core W!ndows server 2003
. Windows Server 2008
recommended, depending upon volume

projections) U] Designer and Admin support:
O 4 GB RAM Windows XP
Windows Vista
L] 10 GB usable disk space (additional Windows 7

storage for databases required
& g ) [] Message Queuing Component/Feature *

L] 100BaseTX Ethernet Network Adapter 0 NETF k3.5 SP1 or later*
(Gigabit Ethernet recommended) ’ ramework 3. orlater

O Separate Hardware RAID 10 volumes are [ SMTP-compliant server in the enterprise

recommended for database data, index, [] Database server with one of the following:
and log files (when used in production Microsoft SQL Server 2005 Express**
environment) Microsoft SQL Server 2005 Standard

Microsoft SQL Server 2005 Enterprise
Microsoft SQL Server 2008 Express™**
Microsoft SQL Server 2008 Standard

Microsoft SQL Server 2008 Enterprise

* These files can be downloaded for free from Microsoft’s web site (www.microsoft.com).

~

Only required on the server hosting the Process Engine service. For Server 2003, you only need to
select the Common subcomponent of the Message Queuing component. For Server2008, you only need
to select the Message Queuing Server service of the Message Queuing feature.

*k Expect limited performance when using Express editions. Express editions not recommended.

Bluespring recommends that BPM;s be installed on a minimum of two servers to get started. Additional
Workspace and Runtime servers may be required to support your process development lifecycle.

Workspace and Runtime Server

This server hosts the Workspace, Process Engine, Task, Notification, and Scheduling services for
one runtime environment. The first runtime environment will likely be your “development”
runtime environment. You can then stand up subsequent runtime environments (additional
servers) to support testing, staging, and production environments.

SQL Server Database Server
If you have a non-virtualized instance of SQL, then Bluespring requests that you create a named
SQL instance to hold the one Bluespring Workspace database and one-to-many runtime
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databases. If the SQL Server is virtualized, then Bluespring will need to understand the specs and

how the virtualization was configured.

Bluespring Support Policy

Bluespring Software is committed to providing you with the best overall product experience. Our

products are designed with superior quality and ease of use in mind, but we understand that issues do

arise from time to time that need the backing of our support resources.

For more information, please contact Bluespring Software’s Customer Support Operations at (877) 871-

9566.

Bluespring support services are subject to the prices, terms, and conditions in place at the time the

services are used.

Contact Information

Address:

Telephone:

Fax:

WWW:

Email:

Office hours:

200 West Fourth Street
Sixth Floor

Cincinnati, Ohio
45202

(513) 794-1764 (Cincinnati)
(877) 871-9566 (Toll Free)

(513) 794-1724

www.bluespringsoftware.com
www.bluespringonline.com

support@bluespringsoftware.com

Monday to Friday
8:00 A.M. to 5:00 P.M. Eastern Time

ad
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Installing BPM Workspace Service

The BPM Workspace Service manages communication between the BPM 5 services, the BPM 5
Workspace Database, and the BPM 5 Runtime Databases.

To install the BPM Workspace Service, complete the following steps:

1. Double-click the BPM Workspace setup file (bpm workspace.msi). The BPM Workspace 5 Setup
Wizard is displayed.

Note: If you encounter an error during the install, please retry the install, but double-
click the bpm workspace.bat file to start the install. Using that file will generate
a detailed installation log file. You can send this log file to Bluespring Support for

assistance.

i Bluespring BPM Workspace 5 Setup o ] |
Welcome to the Bluespring BPM
Workspace 5 Setup Wizard

The Setup Wizard will install Bluespring BFM Workspace 5 on
your computer, Click Next to continue or Cancel to exit the
Setup Wizard.

Back I Mext I Cancel

— 3 83 Bnp
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2. Click Next. The End-User License Agreement screen is displayed
iiél- Bluespring BPM Workspace 5 Setup - |D|ﬂ

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select the | accept the terms in the License Agreement checkbox.

il Bluespring BPM Workspace 5 Setup M= B3

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

IV T accept the terms in the License Agreement

Print Back. I Mesxt I Cancel |

3 8 B npP
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4. Click Next. The Destination Folder screen is displayed.

il
Destination Folder
Click Next to install to the default folder or dick Change to choose another.

Install Bluespring BPM Workspace 5 to:

IC: \Program Files\Bluespring BPM 5

Change... |

Back I Mext I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM Workspace Service files.

5. Click Next. The HTTP Server screen is displayed.

i'.;!;'u Bluespring BPM Workspace 5 Setup - |EI|5|

HTTP Server
Configure HTTP settings.

Hostname:

Server Details:

Port number: IQDDD

Frotocol: * HTTP (" HTIPS

Back I Mext I Cancel

6. Inthe Hostname field, type the name of the host server.

Note: Bluespring recommends using the server’s Fully Qualified Domain Name
(FQDN). If you do not know the server’s FQDN, please contact your IT
department.

33 aap
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For example, if your domain is called domain.net and the server name is BPM,
then the FQDN would be bpm.domain.net.

7. Inthe Server Details fields:
a. Type the port number in the Port number field. The Workspace Service will listen for

requests on this port.

Note: Port 9000 is the default port used by BPM 5’s services; however, you can change
the port number if port 9000 is used by another application.

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data
and HTTPS to transmit encrypted data.

Note: Using HTTPS requires additional system configuration for security certificates.
Please contact Bluespring Support if interested in using HTTPS.

8. Click Next. The SQL Server screen is displayed.

iié'u Bluespring BPM Workspace 5 Setup o ] 4

S0QL Server
Select the SQL Server.,

SOL Server Name:

WS 2008R 2VMDK\BPM

Login Credentials:
% windows Authentication

™ 50L Authentication

Password: |

Back I Mext I Cancel |

9. Inthe SQL Server Name field, type the name of your Microsoft SQL Server 2005/2008 server and
SQL instance, if applicable.

Note: The SQL Server instance must be configured to use mixed mode authentication,
so it can support SQL logins.

10. From the Login Credentials fields, select the required authentication type.

Note: Windows Authentication will use the account of the Windows user performing
the install. If that user does not have System Administrator (sysadmin)
permissions to the server, then select the SQL Authentication option and enter
the credentials of a SQL login account. This account is used only while creating
the Workspace database and, if necessary, SQL logins.

11. Click Next. The Workspace Database screen is displayed.

— 3 83 Bnp
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iz Bluespring BPM Workspace 5 Setup o =] [

Workspace Database
Configure the database connection.

Database Name:

|Bpm\“a'nrkspace

SQL Login for Workspace Service:

User name: | Create Mew. .. |

Password: |

Back Iexk | Cancel |

12. In the Database Name field, type a name for your Workspace database.
13. In the SQL Login for Workspace Service fields, click Create New. The Create SQL Login window is
displayed.

Note: If you have a SQL Login, type that user name and password in the respective
fields and skip to step 15. The account will be added to a new SQL role called
Bluespring.

You type the credentials for a new SQL user account used by the Workspace
Service to connect to the Workspace database.

iiéil Create S0L Login ﬂ

User name: |

Password: |

Confirm password: |

14. Complete the following fields:
a. Inthe User name field, type the user name.
b. Inthe Password field, type the user’s password.
c. Inthe Confirm password field, retype the password.
15. Click OK. You created a new SQL login for the Workspace service.

11
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16. Click Next. The Client Login screen is displayed.

iiél- Bluespring BPM Workspace 5 Setup

Client Login
Configure the database login for dient applications.

=101 ]

Login for BPM client applications:

Create Mew. .. |

User name: |

Password: |

ng

TWARE
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bluespr

Back ek | Cancel |

17. In the Login for BPM client applications fields, click Create New. The Create SQL Login window is

displayed.

This login will be used by BPM Designer clients to read and write information to the Workspace

database.

Note:

If you have a SQL Login, type that user name and password in the respective

fields and skip to step 19. The Client SQL login is assigned lesser permissions
than the Workspace Login. Bluespring recommends that you do not use the
Workspace Login for the client login because of the security differences.

x|

ii|.‘!r1' Create 50L Login

User name: |

Password: |

Confirm password: |

18. Complete the following fields to create a new SQL login:
In the User name field, type your user name.

a.
b. Inthe Password field, type your password.
c. Inthe Confirm password field, retype the password.

19. Click OK. You created a new login for BPM client applications.

L
12 ;
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20. Click Next. The Ready to install Bluespring BPM Workspace 5 screen is displayed.

i Bluespring BPM Workspace 5 Setup i ] 4|

Ready to install Bluespring BPM Workspace 5 @

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel |

21. Click Install. The installation begins. When complete, the Completed the Bluespring BPM
Workspace 5 Setup Wizard screen is displayed.
i‘é’- Bluespring BPM Workspace 5 Setup o ] oA |

Completed the Bluespring BPM
Workspace 5 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish I CACE| |

22. Click Finish. You installed the Bluespring BPM Workspace Service 5.

Verifying the BPM Workspace Service 5 Installation

Verify that your installation was successful by checking for errors in the service’s log file or by checking
the service’s status in the Services utility or both.

To check for errors in the Bluespring Workspace log file, complete the following steps:

33 -a@3ap
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1. Navigate to the Workspace Service folder. This is the folder you selected as the destination
folder in step 4 of Installing the BPM Workspace Service.
2. Open the Bluespring Workspace Service log file (Bluespring.WorkspaceService.log).

You should not see any errors and see two lines similar to the following two lines:

e 2010-06-14 22:41:42 WorkspaceService running =>
http://bpm:9000/Bluespring/Workspace.ashx
e 2010-06-14 22:41:42 IWorkspaceHttpService running => http://bpm:9000/Bluespring

To check the BPM Workspace Service installation status in the Services utility, complete the following

steps:

1. From the Start menu, select Administrative Tools and then select Services.
2. Inthe Services window, select Bluespring Workspace Service. The status of the selected service
is displayed as Started under the Status column.

Note: If the installation is successful, the status will be displayed as Started.

— 3 83 Bnp
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Creating a Runtime Database

You need to create a runtime database for each BPM 5 Runtime environment. Typically, companies

using BPM 5 will have three runtime environments, which are separate for Development, Testing, and

Production.

To create a BPM 5 Runtime database, complete the following steps:

1.

From the Start menu on the Workspace Service server, select All Programs > Accessories.
Right-click Command Prompt.
Select Run as administrator. The Administrator: Command Prompt window is displayed.

Note: You do not need to complete steps one through three, if you are using Windows Server

2003 or if your User Account Controls are disabled.

[z+.| Administrator: Command Prompt

Microsoft Windows [Uersion 6.1.7668081
Copyright <c> 288% Microszoft Corporation. All rightsz reserved.

C:sUserssfAdmninistrator>ed “c:SNProgram Files“Bluespring BPM 5-:hin"'
c:“Program Filez“Bluespring BPM 5%“hin>runtimedb add BpmBuntime -z (local>~BPM

Navigate to the bin folder in the BPM Workspace Destination folder.

Note: This folder is the destination folder that you selected in Step 3 of the Installing
the BPM Workspace Service steps.

Enter the following command and any parameters as necessary:

runtimedb add <runtime database name>

Note: The SQL Server instance must be configured to use mixed mode authentication,
so that it can support SQL logins.

The runtimedb command also supports the switches (or parameters) in the following table:

Switch Description

-cu Existing SQL user account to be used as the BPM 5 runtime login. The default

15
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account is client_<WorkspaceDatabase> if empty.

Existing SQL user’s password. Auto-generated if empty.

Package file. The default is RuntimeDB.sqlx.

Prevents the display of logo information

SQL server and instance. The default is local, if empty. You must specify a
value if the Workspace Server is not your SQL Server.

SQL user account used to create the runtime database and, if necessary,
user.

SQL user’s password.

Optional. SQL command timeout in seconds.

6. Pressthe Enter key. The command starts executing. When complete, the Operation completed

successfully message is displayed.

ministrator: Command Prompt

Microsoft Windows [Verzion 6.1.7668081
Copyright ¢c? 288% Microsoft Corporation. All rights reserved.

C:wUgerssAdminiztrator>ecd “c:“Program Files“Bluezpring BPM 5-bin"

c:“Program Files“Bluespring BPH 5“hin>runtimedh add BpmBuntime -3 {(local>~BPH
Bluespring Runtime Database Utility Uersion 5.8.688_.235
Copyright <c? Bluespring Solutions. All rights reserved.

Executing Create scripts...
Executing Databasze scripts...
Executing Tables scripts...

Executing Uiews scripts

Executing ForeignHew

Executing StoredProcedures scripts...
Executing Triggers scripts

Executing BaseContent scri

Executing Updates scripts

Executing Yorkspace scripts...

Operation completed successfully.

c:“Program Files“Bluespring BPH 5%hin>

7. Exit the command prompt. You created a runtime database.

Note: You need to select this runtime database while installing the Process Engine

Service, Task Service, Scheduling Service, and Notification Service.

16
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Updating the SMTP Information Table in the Workspace Database

You need to update the SMTP information table (Smtpinfo) after you have installed the BPM Workspace
service and created the Runtime Database. You update this table, so the Notification Service knows
which SMTP server to use when sending emails.

Note: These steps assume you have knowledge of Microsoft SQL Server Management
Studio and have executed queries against Microsoft SQL Server databases. If
you have questions, please contact your Microsoft SQL Server Database
Administrator.

To update the SMTP information table in the Workspace database, complete the following steps:

1. Connect to the SQL server and instance hosting your Workspace database, using Microsoft SQL
Server Management Studio.
2. Select the following:
a. From the Server type drop down list, the type of the server (e.g. Database Engine).
b. From the Server name drop down list, the name of your SQL server.
c. From the Authentication drop down list, the required authentication.
3. Click Connect. The Microsoft SQL Server Management Studio window is displayed.
4. On the toolbar, click New Query.
5. Type the following query:

DECLARE @SmtpServer as varchar (50)

DECLARE @RuntimeDatabase as wvarchar (50)

SET @SmtpServer = '<SMTP Server>'

SET @RuntimeDatabase = '<Runtime Database Name>'

DECLARE @EnvID as uniqueidentifier

SELECT TOP 1 QEnvID = ID FROM Environment
WHERE [Name]= @RuntimeDatabase

INSERT INTO SmtpInfo (EnvironmentID, Host, Port, Timeout)
VALUES (Q@EnvID, @SmtpServer, 25, 60000)
SELECT * FROM SmtpInfo

Note: Replace the <SMTP Server> and <Runtime Database Name> placeholders with
the name of your SMTP server and the name of your Runtime database,
respectively. For information on the Host and the Port number, contact your IT
department.

3 32 ab
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The query sets the timeout to 1 minute, which is 60000 milliseconds. To change
the timeout, modify the 60000 value before executing the query. You can later
modify the value in the database to increase or decrease the timeout.

Execute the query against your Workspace database. The corresponding ID, Environment ID,
Host name, Port number, and Timeout are displayed in the Results tab.
Exit the SQL Server Management Studio. You updated the SMTP Information table.

18
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Installing BPM Task Service

The BPM Task Service is a Windows service that manages the execution of process activities and the

assignment of tasks to people in a process.
To install the BPM Task Service, complete the following steps:

1. Double-click the BPM task service setup file (bpm task service.msi). The Bluespring BPM Task
Service 5 Setup Wizard is displayed.

Note: If you encounter an error during the install, please retry the install, but double-
click the bpm task service (logfile).bat file to start the install. Using that file will
generate a detailed installation log file. You can send this log file to Bluespring

Support for assistance.

i Bluespring BPM Task Service 5 Setup i ] 4|

Welcome to the Bluespring BPM Task
Service 5 Setup Wizard

The Setup Wizard will install Bluespring BPM Task Service 5
on your computer, Click Next to continue or Cancel to exit
the Setup Wizard.

Back I Next I Cancel

— 3 83 Bnp
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2. Click Next. The End-User License Agreement screen is displayed.
iiél- Bluespring BPM Task Service 5 Setup i ] 4|

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select the | accept the terms in the License Agreement check box.

ji Bluespring BPM Task Service 5 Setup [_[S[x]

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

¥ I accept the terms in the License Agreement

Prink Back. I Mext I Zancel |
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4. Click Next. The Destination Folder screen is displayed.

eIEY
Destination Folder
Click Mext to install to the default folder or dick Change to choose another,

Install Bluespring BPM Task Service 5 to:

IC:'nProgram Files\Bluespring BPM 51,

Change... |

Back I Next I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM Task Service files.

5. Click Next. The BPM Workspace screen is displayed.

6. Inthe Workspace server name field, type the name of the server hosting your Workspace
service.

7. Inthe Port number field, type the Workspace Service’s Port Number.

Note: The port number you enter here should be the same port number you entered on
the HTTP Server screen in the Workspace Service install.

8. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service.
Optionally, to connect as another user, complete the following steps:

e Select the Connect as another user checkbox.
o Type the User name and Password of a domain user that is a member of the Local
Administrators group on the server hosting the Task service.

Note: By default, the Task Service will connect to the Workspace Service using the
Local System account. The Local System account does not have permission to
access the Workspace Service when it is hosted on a remote server.
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9. Click Next. The Runtime Database screen is displayed.

ii.‘-!;I- Bluespring BPM Task Service 5 Setup i ] 4|
Runtime Database
Select a BPM Runtime database.

Workspace Location:
http: /S 2008R. 2VMDK: 5000 Bluespringf

Available runtime database(s):

BpmR.uritime

Back ek | Cancel |

10. From the Available runtime database(s) list, select the Runtime Database that you created in
the section Creating a Runtime Database.
11. Click Next. The HTTP Server screen is displayed.

ii.‘-!;I- Bluespring BPM Task Service 5 Setup - |D|ﬂ

HTTP Server
Configure HTTP settings.

Hostname:

IWS 2008R.2VMDK

Server Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

Back I Next I Cancel

12. In the Hostname field, type the name of the host server.

13. In the Server Details fields type the following details:
a. Type the port number in the Port number field. The Task Service will listen for requests
on this port.

22
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Note: Port 9000 is the default port used by BPM 5’s services; however, you can change
the port number if port 9000 is used by another application

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data
and HTTPS to transmit encrypted data.
14. Click Next. The Ready to install Bluespring BPM Task Service 5 screen is displayed.

i Bluespring BPM Task Service 5 Setup i ] 4|

Ready to install Bluespring BPM Task Service 5 @

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel |

15. Click Install. The Installation begins. When the installation is completed, the Completed the
Bluespring BPM Task Service 5 Setup Wizard screen is displayed.
iz Bluespring BPM Task Service 5 Setup -0 =]

Completed the Bluespring BPM Task
Service 5 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish I CACE| |

16. Click Finish. You installed the Bluespring BPM Task Service 5.

23
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Verifying the BPM Task Service 5 Installation

Verify that your installation was successful by checking for errors in the service’s log file or by checking
the service’s status in the Services utility or both.

To check for errors in the Bluespring Task Service log file, complete the following steps:

1. Navigate to the Task Service folder. This is the folder you selected as the destination folder in
step 4 of Installing the BPM Task Service.
2. Open the Bluespring Task Service log file (Bluespring.TaskService.log).
You should not see any errors and the first three lines should be similar to the following lines:
e 2010-06-17 14:20:34 ITaskService stopped => http://bpm-
ga.ga.bluessw.net:9000/Bluespring/BpmRuntime/Tasks.ashx
e 2010-06-17 14:20:34 ITaskHttpService stopped => http://bpm-
ga.ga.bluessw.net:9000/Bluespring/BpmRuntime/tasks
e 2010-06-17 14:20:34 |EventCallback stopped => http://bpm-
ga.ga.bluessw.net:9000/Bluespring/BpmRuntime/Tasks/Callback.ashx

To check the BPM Task Service installation status in the Services utility, complete the following steps:

1. From the Start menu, select Administrative Tools and then select Services.
2. Inthe Services window, select Bluespring Task Service. The status of the selected service is
displayed as Started under the Status column
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The BPM Notification Service is used to send notifications to a user. For example, the Notification
Service is used by the Send Email activity and by the activities that can send task notifications.
Notifications can be sent when a task is assigned, escalated, reassigned, completed, timed out, or failed.

To install the BPM Notification Service, complete the following steps:

1. Double-click the BPM Notification Service setup file (bpm notification service.msi). The
Bluespring BPM Notification Service 5 Setup wizard is displayed.

Note: If you encounter an error during the install, please retry, but double-click the
bpm notification service (logfile).bat file to start the install. Using the install file
will generate a detailed installation log file. You can send this log file to

Bluespring Support for assistance.

iiél- Bluespring BPM Notification Service 5 Setup i ] 4|
Welcome to the Bluespring BPM
Notification Service 5 Setup Wizard

The Setup Wizard will install Bluespring BPM Motification
Service 5 on your computer. Click Next to continue ar Cancel
to exit the Setup Wizard.

Back I Next I Cancel
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2. Click Next. The End-User License Agreement screen is displayed.
iiél- Bluespring BPM Notification Service 5 Setup i ] 4|

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select the | accept the terms in the License Agreement check box.

i Bluespring BPM Notification Service 5 Setup

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

¥ I accept the terms in the License Agreement

Prink Back. I Mext I Zancel |
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4. Click Next. The Destination Folder screen is displayed.

iiél- Bluespring BPM Notification Service 5 Setup i ] 4|

Destination Folder
Click Mext to install to the default folder or dick Change to choose another,

Install Bluespring BPM Notification Service 5 to:

IC:'nProgram Files\Bluespring BPM 51,

Change... |

Back I Next I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM Notification Service files.

5. Click Next. The BPM Workspace screen is displayed.

iiél- Bluespring BPM Notification Service 5 Setup i ] 4|

BPM Workspace
Configure a BPM Workspace connection,

Workspace server name:

IWS 2008R.2VMDK

Connection Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

[ Connect as another user,

User name: |

Password: |

Back I Next I Cancel |

6. Inthe Workspace server name field, type the name of your workspace server.

7. Inthe Port number field, type the Workspace Service’s Port Number.

Note: The port number you enter here should be the same port number you entered
on the HTTP Server screen in the Workspace Service install.
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Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service.
Optionally, to connect as another user, complete the following steps:

e Select the Connect as another user checkbox.
e Type the User name and Password of a domain user that is a member of the Local
Administrators group on the server hosting the Notification service.

Note: By default, the Notification service will connect to the Workspace Service using
the Local System account. The Local System account does not have permission
to access the Workspace Service when it is hosted on a remote server.

Click Next. The Runtime Database screen is displayed.

iiél- Bluespring BPM Notification Service 5 Setup i ] 4|
Runtime Database
Select a BPM Runtime database.

Workspace Location:
http: /S 2008R. 2VMDK: 5000 Bluespringf

Available runtime database(s):

Back I Next I Cancel |

10. From the Available runtime database(s) list, select the Runtime Database that you created in

the section Creating a Runtime Database.
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11. Click Next. The HTTP Server screen is displayed.
L1

HTTP Server
Configure HTTP settings.

Hostname:

IWS 2008R.2VMDK

Server Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

Back I Next I Cancel

12. In the Hostname field, type the name of the host server.
13. In the Server Details fields type the following:
a. The port number in the Port number field. The Notification Service will listen for
requests on this port.

Note: Port 9000 is the default port used by BPM 5’s services; however, you can change
the port number if port 9000 is used by another application.

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data
and HTTPS to transmit encrypted data.

3 8 B npP
._: J realizingthe PowerofProcess
people and systems at work



b
bluespring

TWARE

14. Click Next. The Ready to install Bluespring BPM Notification Service 5 screen is displayed.

iiél- Bluespring BPM Notification Service 5 Setup i ] 4|

Ready to install Bluespring BPM Notification Service 5 @

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel |

15. Click Install. The installation begins. When complete, the Completed the Bluespring BPM
Notification Service 5 Setup Wizard screen is displayed.
iz Bluespring BPM Notification Service 5 Setup o ] oA |

Completed the Bluespring BPM
Notification Service 5 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish I CACE| |

16. Click Finish. You installed the Bluespring BPM Notification Service 5.

Verifying the BPM Notification Service 5 Installation

Verify that your installation was successful by checking for errors in the service’s log file or by checking
the service’s status in the Services utility or both.

To check for errors in the Bluespring Notification Service log file, complete the following steps:
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To check the installation status in the Services utility, complete the following steps:

From the Start menu, select Administrative Tools.

. Select Services. The Services window is displayed.
3. Select Bluespring Notification Service. The status of the selected service is displayed as Started

under the Status column.

Note: If the installation is successful, the status will be displayed as Started.
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The BPM Scheduling service manages the starting of processes configured to use the Scheduled Start

and any process delays configured in the Delay Process activity.
To install the BPM Scheduling Service, complete the following steps:

1. Double-click the BPM Scheduling Service setup file (bpm scheduling service.msi). The Bluespring
BPM Scheduling Service 5 Setup Wizard is displayed.

Note: If you encounter an error during the install, please retry, but double-click the
bpm scheduling service (logfile).bat file to start the install. Using the install file
will generate a detailed installation log file. You can send this log file to

Bluespring Support for assistance.

i Bluespring BPM Scheduling Service 5 Setup o ] [
Welcome to the Bluespring BPM
Scheduling Service 5 Setup Wizard

The Setup Wizard will install Bluespring BPM Scheduling
Service 5 on your computer. Click Next to continue ar Cancel
to exit the Setup Wizard.

Back I Next I Cancel
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2. Click Next. The End-User License Agreement screen is displayed.
i Bluespring BPM Scheduling Service 5 Setup o ] [

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select the | accept the terms in the License Agreement check box.

i‘é’- Bluespring BPM Scheduling Service 5 Setup [_ (D] x|

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

¥ I accept the terms in the License Agreement

Prink Back. I Mext I Zancel |
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4. Click Next. The Destination Folder screen is displayed.

iiél- Bluespring BPM Scheduling Service 5 Setup i ] 4|

Destination Folder
Click Mext to install to the default folder or dick Change to choose another,

Install Bluespring BPM Scheduling Service 5 to:

IC:'nProgram Files\Bluespring BPM 51,

Change... |

Back I Next I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM Scheduling Service files.

5. Click Next. The BPM Workspace screen is displayed.

iiél- Bluespring BPM Scheduling Service 5 Setup i ] 4|

BPM Workspace
Configure a BPM Workspace connection,

Workspace server name:

IWS 2008R.2VMDK

Connection Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

[ Connect as another user,

User name: |

Password: |

Back I Next I Cancel |

6. Inthe Workspace server name field, type the name of your Workspace server.

7. Inthe Port number field, type the Workspace Service’s Port Number.

Note: The port number you enter here should be the same port number you entered
on the HTTP Server screen in the Workspace Service install
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Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service.
Optionally, to connect as another user, complete the following steps:

e Select the Connect as another user checkbox.
e Type the User name and Password of a domain user that is a member of the Local
Administrators group on the server hosting the Scheduling service.

Note: By default, the Scheduling Service will connect to the Workspace Service using
the Local System account. The Local System account does not have permission
to access the Workspace Service when it is hosted on a remote server.

Click Next. The Runtime Database screen is displayed.

iiél- Bluespring BPM Scheduling Service 5 Setup i ] 4|
Runtime Database
Select a BPM Runtime database.

Workspace Location:
http: /S 2008R. 2VMDK: 5000 Bluespringf

Available runtime database(s):

Back I Next I Cancel |

10. From the Available runtime database(s) list, select the Runtime Database that you created in

the section Creating a Runtime Database.
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11. Click Next. The HTTP Server screen is displayed.

iiél- Bluespring BPM Scheduling Service 5 Setup
HTTP Server
Configure HTTP settings.

°
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=101 ]

Hostname:

IWS 2008R.2VMDK

Server Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

Back I Next I

Cancel

12. In the Hostname field, type the name of your host server.

13. In the Server Details fields:

a. Type the port number in the Port number field. The Scheduling Service will listen for

requests on this port.

Note: Port 9000 is the default port used by BPM 5’s services; however, you can change
the port number if port 9000 is used by another application.

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data

and HTTPS to transmit encrypted data.
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14. Click Next. The Ready to install Bluespring BPM Scheduling Service 5 screen is displayed.

i Bluespring BPM Scheduling Service 5 Setup i ] 4|

Ready to install Bluespring BPM Scheduling Service 5 @

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel |

15. Click Install. The installation begins. When complete, the Completed the Bluespring BPM
Scheduling Service 5 Setup Wizard screen is displayed.
iz Bluespring BPM Scheduling Service 5 Setup -0 =]

Completed the Bluespring BPM
Scheduling Service 5 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish I CACE| |

16. Click Finish. You installed the Bluespring BPM Scheduling Service 5.

Verifying the BPM Scheduling Service 5 Installation

Verify that your installation was successful by checking for errors in the service’s log file or by checking
the service’s status in the Services utility or both.
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To check the BPM Scheduling Service installation status in the Services utility, complete the following
steps:

1. From the Start menu, select Administrative Tools and then select Services.
2. Inthe Services window, select Bluespring Scheduling Service. The status of the selected service
is displayed as Started under the Status column.

Note: If the installation is successful, the status will be displayed as Started.
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Installing BPM Process Engine

The BPM Process Engine is a Windows service that manages the processing of activities and information

in a solution.
To install the BPM Process Engine complete the following steps:

1. Double-click the BPM Process Engine setup file (bpm process engine.msi). The Bluespring BPM
Process Engine 5 Setup Wizard is displayed.

Note: If you encounter an error during the install, please retry the install, but double-
click the bpm process engine (logfile).bat file to start the install. Using that file
will generate a detailed installation log file. You can send this log file to

Bluespring Support for assistance.

iiél- Bluespring BPM Process Engine 5 Setup i ] 4|

Welcome to the Bluespring BPM Process
Engine 5 Setup Wizard

Back I Next I Cancel
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2. Click Next. The End-User License Agreement screen is displayed.
iiél- Bluespring BPM Process Engine 5 Setup - |D|ﬂ

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select the | accept the terms in the License Agreement check box.

i‘é’- Bluespring BPM Process Engine 5 Setup [_ [ x]

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

¥ I accept the terms in the License Agreement

Prink Back. I Mext I Zancel |
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4. Click Next. The Destination Folder screen is displayed.

ii.‘-!;I- Bluespring BPM Process Engine 5 Setup - |D|ﬂ

Destination Folder
Click Mext to install to the default folder or dick Change to choose another,

Install Bluespring BPM Process Engine 5 to:

IC:'nProgram Files\Bluespring BPM 51,

Change... |

Back I Next I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM Process Engine files.

5. Click Next. The BPM Workspace screen is displayed.

Sk
BPM Workspace

Configure a BPM Workspace connection,

Workspace server name:

IWS 2008R.2VMDK

Connection Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

[ Connect as another user,

User name: |

Password: |

Back I Next I Cancel |

6. Inthe Workspace server name: field, type the name of the server hosting your Workspace

service.
7. Inthe Port number field, type the Workspace Service’s Port Number.
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Note: The port number you enter here should be the same port number you entered
on the HTTP Server screen in the Workspace Service install.

8. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service.

Optionally, to connect as another user, complete the following steps:

e Select the Connect as another user checkbox.
o Type the User name and Password of a domain user that is a member of the Local
Administrators group on the server hosting the File Monitor service.

Note: By default, the Process Engine service will connect to the Workspace Service
using the Local System account. The Local System account does not have
permission to access the Workspace Service when it is hosted on a remote

server.

9. Click Next. The Runtime Database screen is displayed.

i‘é’- Bluespring BPM Process Engine 5 Setup - |D|l|
Runtime Database
Select 3 BPM Runtime database.

Workspace Location:
http: /WS 2008R 2VMDK: 3000 ,/Bluespring

Available runtime database(s):

Back I Mext I Cancel |

10. From the Available runtime database(s) list, select the Runtime Database that you created in
the section Creating a Runtime Database.
11. Click Next. The HTTP Server screen is displayed.

42

— 3 83 Bnp
. ﬂ realizingthe PowerofProcess
people and systems at work



b
bluespring

TWARE

i‘é’- Bluespring BPM Process Engine 5 Setup - |D|l|

HTTP Server
Configure HTTP settings.

Hostname:

IWS 2008R.2VMDK

Server Details:

Port number: IQDDD

Protocol: & HTTP HTTPS

Back I Mext I Cancel

12. In the Hostname: field, type the name of your host server.
13. In the Server Details fields:
a. Type the port number in the Port number field. The Process Engine Service will listen for
requests on this port.

Note: Port 9000 is the default port used by BPM 5’s services; however, you can change
the port number if port 9000 is used by another application.

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data
and HTTPS to transmit encrypted data.
14. Click Next. The Ready to install Bluespring BPM Process Engine 5 screen is displayed.
R IeTE

Ready to install Bluespring BPM Process Engine 5 @

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel
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15. Click Install. The installation begins. When complete, the Completed the Bluespring BPM
Process Engine 5 Setup Wizard screen is displayed.
i‘é’- Bluespring BPM Process Engine 5 Setup o ] oA |

Completed the Bluespring BPM Process
Engine 5 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish I CACE| |

16. Click Finish. You installed the Bluespring BPM Process Engine 5 and now you have to activate the
service for it to properly function. Please see the next section, Activating the BPM Process
Engine 5 Installation.

Activating the BPM Process Engine 5 Installation

When the Process Engine install completes you will be prompted to activate BPM Process Engine 5. To
activate you will need either your Trial or Full license credentials provided by Bluespring.

Note: If you do not have Internet access on the server, access the activation website from
another location to retrieve your activation code. See Appendix F for further instructions.

To activate your Process Engine, complete the following steps:

1. Inthe User ID field of the Activate BPM5 Process Engine window, enter the User ID from the
license you received from Bluespring. The User ID will be a series of numbers (Example: 1234).

2. Inthe Password field, enter the password associated with the User ID you received from
Bluespring.

Note: By default, the | want to activate the software over the internet option is selected.
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Activate BPM5 Process Engine E

BPME Process Engine 5.1.1306.1237

Activation Wizard

Thank. you for instaling BPME Process Engine 5113061237, You must activate pour
installation to enable vour license. This wizard will guide vou through the activation process.

Enter your User ID and Password you received when vou purchased your copy of BPM5
Process Engine.

User D || | Pazsword |

How do you want to activate vour copy of the software?

% | want ko activate the software over the Internet. [Fecommended)

| want ko activate the software through the activation website.

Back | MHext | Cancel |
Contact Support

3. Click Next. The activation status page is displayed.

Activate BPM5 Process Engine E

BPME Process Engine 5.1.1306.1237

Activation Wizard

Thank you. Your copy of BPME Process Enagine 5.1.1306.1237 is activated.

Flease take a few minutes and register vour copy of BPMS Process Engine for product

suooart.
Fiegister Mo, . |

Hach Hext
Contact Support = | =

Note: Registration is optional. If you do not want to register you
step 4.

r copy of the service, skip to

Click Close in the Activate BPMS5 Process Engine window. The Activated window is displayed
indicating you successfully activated BPM5 Process Engine through the internet and now you

want to start the Process Engine service.
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Activated

Wiould you like to stark the Process Engine Service now?

5. Click Yes to start the Process Engine Service. You started the Process Engine Service.

Verifying the BPM Process Engine 5 Installation

Verify that your installation was successful by checking for errors in the service’s log file or by checking
the service’s status in the Services utility or both.

To check for errors in the Bluespring Process Engine log file, complete the following steps:

1. Navigate to the Process Engine folder. This is the folder you selected as the destination folder in
step 4 of Installing the BPM Process Engine.
2. Open the Bluespring Process Engine Service log file (Bluespring.ProcessEngine.log).
You should not see any errors and see lines similar to the following lines:
e 2010-06-19 07:03:37 Engine: Start [CALLED]
e 2010-06-19 07:03:37 Engine: StartAllPlugins [CALLED]

To check the installation status in the Services utility, complete the following steps:

1. From the Start menu, select Administrative Tools and then select Services.
2. Inthe Services window, select Bluespring Process Engine. The status of the selected service is
displayed as Started under the Status column.

Note: If the installation is successful, the status will be displayed as Started.
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Installing BPM File Monitor Service

The BPM File Monitor Service is a Windows service used to monitor file shares for file events. When a
file event occurs, the BPM File Monitor Service will start an instance of a process in BPM. The process
started will include the Receive File Monitor Event activity and be configured to use the File Monitor

Service System Resource.

The File Monitor Service can be installed on the server hosting your other BPM 5 services; however,
Bluespring recommends installing the service on the server that contains the directory or folder being
monitored. Network latency may cause undesired results if the File Monitor service is monitoring a
network folder or directory not available on the File Monitor service’s server.

To install the BPM File Monitor Service, complete the following steps:

1. Double-click the BPM File Monitor Service setup file (bpm file monitor service.msi). The
Bluespring BPM File Monitor 5 Setup Wizard is displayed.

Note: If you encounter an error during the install, please retry, but double-click the
bpm file monitor service (logfile).bat file to start the install. Using the install file
will generate a detailed installation log file. You can send this log file to

Bluespring Support for assistance.

iz Bluespring BPM File Monitor 5 Setup o ] oA |
Welcome to the Bluespring BPM File
Monitor 5 Setup Wizard

The Setup Wizard will install Bluespring BPM File Monitor 5 on
your computer, Clids Next to continue or Cancel to exit the
Setup Wizard.

Back I Mext I Cancel
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2. Click Next. The End-User License Agreement screen is displayed.
iiél- Bluespring BPM File Monitor 5 Setup i ] 4|

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select the | accept the terms in the License Agreement check box.

i Bluespring BPM File Monitor 5 Setup M= B3

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

¥ I accept the terms in the License Agreement

Prink Back. I Mext I Zancel |
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4. Click Next. The Destination Folder screen is displayed.

ii.‘-!;I- Bluespring BPM File Monitor 5 Setup - |D|ﬂ

Destination Folder
Click Mext to install to the default folder or dick Change to choose another,

Install Bluespring BPM File Monitor 5 to:

IC:'nProgram Files\Bluespring BPM 51,

Change... |

Back I Next I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM File Monitor Service files.

5. Click Next. The BPM Workspace screen is displayed.

ii.‘-!;I- Bluespring BPM File Monitor 5 Setup - |D|ﬂ

BPM Workspace
Configure a BPM Workspace connection,

Workspace server name:

IWS 2008R.2VMDK

Connection Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

[ Connect as another user,

User name: |

Password: |

Back I Next I Cancel |

6. Inthe Workspace server name field, type the name of the server hosting your Workspace

service.
7. Inthe Port number field, type the Workspace Service’s Port Number.
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Note: The port number you enter here should be the same port number you entered
on the HTTP Server screen in the Workspace Service install.

Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service.
Optionally, to connect as another user, complete the following steps:

e Select the Connect as another user checkbox.
e Type the User name and Password of a domain user that is a member of the Local
Administrators group on the server hosting the File Monitor service.

Note: By default, the File Monitor service will connect to the Workspace Service using
the Local System account. The Local System account does not have permission
to access the Workspace Service when it is hosted on a remote server.

Click Next. The Ready to install Bluespring BPM File Monitor 5 screen is displayed.

iz Bluespring BPM File Monitor 5 Setup o =] [

Ready to install Bluespring BPM File Monitor 5 @

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel
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10. Click Install. The installation begins. When complete, the Completed the Bluespring BPM File
Monitor 5 Setup Wizard screen is displayed.
iz Bluespring BPM File Monitor 5 Setup ] 4|

Completed the Bluespring BPM File
Monitor 5 Setup Wizard

Back I Finish I CACE| |

11. Click Finish. You installed the Bluespring BPM File Monitor 5.

Verifying the BPM File Monitor Installation
Verify that your installation was successful by checking the service’s status in the Services utility.
To check the installation status in the Services utility, complete the following steps:

1. From the Start menu, select Administrative Tools and then select Services.
2. Inthe Services window, select Bluespring File Monitor. The status of the selected service is
displayed as Started under the Status column.

Note: If the installation is successful, the status will be displayed as Started.

33 a2 ap
. 03 realizingthe PowerofProcess
52 people and systems at work



b
bluespring
Installing BPM SharePoint Service

The BPM SharePoint Service is a Windows service that enables communication among BPM services.

This service runs on Microsoft SharePoint 2007 servers.
To install the BPM SharePoint Service, complete the following steps:

1. Double-click the BPM SharePoint 5 setup file (bpm sharepoint.msi). The Bluespring BPM
SharePoint 5 Setup Wizard is displayed.

Note: If you encounter an error during the install, please retry the install, but double-
click the bpm sharepoint (logfile).bat file to start the install. Using that file will
generate a detailed installation log file. You can send this log file to Bluespring

Support for assistance.

iiél- Bluespring BPM SharePoint 5 Setup i ] 4|

Welcome to the Bluespring BPM
SharePoint 5 Setup Wizard

The Setup Wizard will install Bluespring BPM SharePoint 5 on
your computer. Click Next to continue or Cancel to exit the

Setup Wizard.

Back I Next I Cancel
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2. Click Next. The End-User License Agreement screen is displayed.
iiél- Bluespring BPM SharePoint 5 Setup i ] 4|

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select the | accept the terms in the License Agreement check box.

i Bluespring BPM for SharePoint 5 Setup [_ =] =]

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

¥ I accept the terms in the License Agreement

Prink Back. I Mext I Zancel |
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4. Click Next. The Destination Folder screen is displayed.

iiél- Bluespring BPM SharePoint 5 Setup i ] 4|

Destination Folder
Click Mext to install to the default folder or dick Change to choose another,

Install Bluespring BPM SharePoint 5 to:

IC:'nProgram Files\Bluespring BPM 51,

Change... |

Back I Next I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM SharePoint Service files.

5. Click Next. The BPM Workspace screen is displayed

iiél- Bluespring BPM SharePoint 5 Setup i ] 4|

BPM Workspace
Configure a BPM Workspace connection,

Workspace server name:

IWS 2008R.2VMDK

Connection Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

[ Connect as another user,

User name: |

Password: |

Back I Next I Cancel |

6. Inthe Port number field, type the Workspace Service’s Port Number.

Note: The port number you enter here should be the same port number you entered
on the HTTP Server screen in the Workspace Service install.

7. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service.
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Optionally, to connect as another user, complete the following steps:

e Select the Connect as another user checkbox.
e Type the User name and Password of a domain user that is a member of the Local
Administrators group on the server hosting the SharePoint service.

Note: By default, the SharePoint service will connect to the Workspace Service using
the Local System account. The Local System account does not have permission
to access the Workspace Service when it is hosted on a remote server.

8. Click Next. The HTTP Server screen is displayed.
L1

HTTP Server
Configure HTTP settings.

Hostname:

IWS 2008R.2VMDK

Server Details:

Part number: IQDDD

Frotocol: & HITP O HTTPS

Back I Next I Cancel

9. Inthe Hostname field, type the name of your host server.
10. In the Server Details fields:
a. Type the port number in the Port number field. The Process Engine Service will listen for
requests on this port.

Note: Port 9000 is the default port used by BPM 5’s services; however, you can change
the port number if port 9000 is used by another application.

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data
and HTTPS to transmit encrypted data.
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11. Click Next. The Ready to Install Bluespring BPM SharePoint 5 screen is displayed.

iiél- Bluespring BPM SharePoint 5 Setup i ] 4|

Ready to install Bluespring BPM SharePoint 5 @

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel |

12. Click Install. The installation begins. When complete, the Completed the Bluespring BPM
SharePoint 5 Setup Wizard screen is displayed.
iz Bluespring BPM SharePoint 5 Setup o ] oA |

Completed the Bluespring BPM
SharePaint 5 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish I CACE| |

13. Click Finish. You installed the Bluespring BPM SharePoint 5.

Verifying the BPM SharePoint 5 Installation
Verify that the installation was successful by checking the service’s status in the Services utility.

To check the installation status in the Services utility, complete the following steps:
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1. From the Start menu, select Administrative Tools and then select Services.
2. Inthe Services window, select Bluespring SharePoint Service. The status of the selected service
is displayed as Started under the Status column.

Note: If the installation is successful, the status will be displayed as Started.

Enabling the Bluespring SharePoint Initiator Feature on SharePoint 2007

Enable the Bluespring SharePoint Initiator feature to ensure that any properly configured process that
utilizes the Receive SharePoint Event activity successfully completes. If the feature is not enabled, the
process that utilizes this activity will fail.

Access the site that you would like to enable the Bluespring feature on.
Locate and click Site Actions > Site Settings.
Click Site features from the Site Administration column.

el

Click Activate in the row designated for the Bluespring SharePoint Initiator feature. You
activated the Bluespring SharePoint Initiator feature.

Enabling the Bluespring SharePoint Initiator Feature on SharePoint 2010

Enable the Bluespring SharePoint Initiator feature to ensure that any properly configured process that
utilizes the Receive SharePoint Event activity successfully completes. If the feature is not enabled, the
process that utilizes this activity will fail.

Access the site that you would like to enable the Bluespring feature on.
Locate and click Site Actions > Site Settings.
Click Manage site features, from the Site Actions category.

el

Click Activate in the row designated for the Bluespring SharePoint Initiator feature. You
activated the Bluespring SharePoint Initiator feature.
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Installing CRM 5

The CRM Monitor Service is used to monitor events and actions within Microsoft Dynamics CRM 4.0. The

monitor will start a process when following a CRM event and pass data about the entity to the process.

To install BPM CRM Monitor Service, complete the following steps:

1.

9.

Double-click the BPM Designer 5 setup file (bpm crmservice.msi). The Bluespring BPM CRM 5
Setup Wizard is displayed.

Note: If you encounter an error during the install, please retry, but double-click the bpm
crm service (logfile).bat file to start the install. Using the install file will generate a
detailed installation log file. You can send this log file to Bluespring Support for
assistance.

Click Next. The End-User License Agreement screen is displayed.
After reading the agreement, select | accept the terms in the License Agreement check box.
Click Next. The Destination Folder screen is displayed.

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM Designer files.

Click Next. The BPM Workspace screen is displayed.
In the Port number field, type the Workspace Service’s Port Number.

Note: The port number you enter here should be the same port number you entered
on the HTTP Server screen in the Workspace Service install.

Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service.
Optionally, to connect as another user, complete the following steps:

e Select the Connect as another user checkbox.
e Type the User name and Password of a domain user that is a member of the Local
Administrators group on the server hosting the SharePoint service.

Note: By default, the CRM service will connect to the Workspace Service using the
Local System account. The Local System account does not have permission to
access the Workspace Service when it is hosted on a remote server.

Click Next. The HTTP Server screen is displayed.

In the Hostname field, type the name of your host server.

10. In the Server Details fields:
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a. Type the port number in the Port number field. The Process Engine Service will listen for
requests on this port.

Note: Port 9000 is the default port used by BPM 5’s services; however, you can change
the port number if port 9000 is used by another application.

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data
and HTTPS to transmit encrypted data.
11. Click Next. The Ready to Install Bluespring BPM CRM 5 screen is displayed.
12. Click Install. The installation begins. When complete, the Completed the Bluespring BPM CRM 5
Setup Wizard screen is displayed.
13. Click Finish. You installed the Bluespring BPM SharePoint 5.

Verifying the BPM CRM 5 Installation
Verify that the installation was successful by checking the service’s status in the Services utility.
To check the installation status in the Services utility, complete the following steps:

1. From the Start menu, select Administrative Tools and then select Services.
2. Inthe Services window, select Bluespring CRM 5. The status of the selected service is displayed
as Started under the Status column.

Note: If the installation is successful, the status will be displayed as Started.
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The BPM Designer 5 is an application used to design and configure process solutions. It is typically used

by Business and Process Analysts.
To install the BPM Designer 5, complete the following steps:

1. Double-click the BPM Designer 5 setup file (bpm designer.msi). The Bluespring BPM Designer 5
Setup Wizard is displayed.

Note: |If you encounter an error during the install, please retry, but double-click the
bpm designer (logfile).bat file to start the install. Using the install file will
generate a detailed installation log file. You can send this log file to Bluespring

Support for assistance.

i Bluespring BPM Designer 5 Setup i ] 4|

Welcome to the Bluespring BPM Designer
5 Setup Wizard

The Setup Wizard will install Bluespring BPM Designer 5 on
your computer. Click Next to continue or Cancel to exit the
Setup Wizard.

Back I Next I Cancel
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2. Click Next. The End-User License Agreement screen is displayed.
i Bluespring BPM Designer 5 Setup i ] 4|

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select | accept the terms in the License Agreement check box.

i‘é’- Bluespring BPM Designer 5 Setup !E[ E

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

¥ I accept the terms in the License Agreement

Prink Back. I Mext I Zancel |
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4. Click Next. The Destination Folder screen is displayed.

ii.‘-!;I- Bluespring BPM Designer 5 Setup - |D|ﬂ

Destination Folder
Click Mext to install to the default folder or dick Change to choose another,

Install Bluespring BPM Designer 5 to:

IC:'nProgram Files\Bluespring BPM 51,

Change... |

Back I Next I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM Designer files.

5. Click Next. The Ready to Install Bluespring BPM Designer 5 screen is displayed.

ii.‘-!;I- Bluespring BPM Designer 5 Setup - |D|ﬂ

Ready to install Bluespring BPM Designer 5

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel
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6. Click Install. The installation process begins. When complete, the Completed the Bluespring

BPM Designer 5 Setup Wizard screen is displayed.
i‘é’- Bluespring BPM Designer 5 Setup o ] oA |

Completed the Bluespring BPM Designer
5 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish I CACE|

7. Click Finish. You installed the Bluespring BPM Designer 5.

Verifying the BPM Designer 5 Installation
Verify that the installation was successful by opening BPM Designer 5 and logging into your workspace.
To open BPM Designer 5 and connect to a workspace, complete the following steps:

1. From the Start menu, click All Programs. The All Programs menu is displayed.
Click Bluespring BPM 5. The list of installed BPM 5 applications is displayed.
Click BPM Designer 5. BPM Designer 5 opens and the Connect to Workspace window is
displayed.

4. Click Workspaces. The Add/Remove Workspace window is displayed.

5. Click Add. The Add Workspace window is displayed.

6. Type the following:
a. The name of the Workspace server in the Workspace server name field

b. The port number in the Port field
c. The appropriate protocol from the Protocol options

Note: The Workspace server name, port number, and the protocol you enter here
should be same as those you entered on the HTTP Server screen in the
Workspace Service install.

7. Click OK.
8. Click Close.
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9. From the Connect to a Workspace drop-down list, select your Workspace.
10. Click Connect. The BPM Designer workspace is displayed.
You successfully installed BPM Designer 5 and connected to a workspace.
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Installing BPM Admin 5

The BPM Admin 5 is an application that is used to monitor instances of process solutions. It is used by

Bluespring administrators.
You use BPM Admin to:

e  Monitor process instances in a runtime database

e Restart a process or an activity

e Cancel a process or an activity

e View process status

e View subprocesses

View data item values before and after activity execution

View activity execution log with informational, warning, and error messages

To install the BPM Admin 5, complete the following steps:

1. Double-click the BPM Admin 5 setup file (bpm admin.msi). The Bluespring BPM Admin 5 Setup
Wizard is displayed.

Note: |If you encounter an error during the install, please retry, but double-click the
bpm admin (logfile).bat file to start the install. Using the install file will generate
a detailed installation log file. You can send this log file to Bluespring Support for

assistance.

{i Bluespring BPM Admin 5 Setup i ] 4|

Welcome to the Bluespring BPM Admin 5
Setup Wizard

The Setup Wizard will install Bluespring BPM Admin 5 on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard.

Back I Next I Cancel
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2. Click Next. The End-User License Agreement screen is displayed.
{i Bluespring BPM Admin 5 Setup i ] 4|

End-User License Agreement

Please read the following license agreement carefully

PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.

1. INTRODUCTION

B CLICKING THE "ACCEPT” BUTTON BELOW, OR BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, Y OU AGREE TO BE BOUND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL OR USE THE
SOFTWARE APPLICATION AND EXIT NOW.

||

[ Iaccept the terms in the License Agreement

Print | Back I ek I Cancel |

3. After reading the agreement, select | accept the terms in the License Agreement check box.

fiz Bluespring BPM Admin 5 Setup H= &

End-User License Agreement

Plzase read the Following license agreement carefully

PLEASE READ THE TERMS AND COMNDITIONS OF THIS LICENSE AGREEMENT ﬂ
CAREFULLY BEFORE IMNSTALLIMG AND USING THE SOFTYWARE.

1. INTRODUCTION

B CLICKING THE "&CCERT" BUTTOM BELCW, OF: BY INSTALLING, COPYING OR
OTHERWISE USING THE SOFTWARE APPLICATION, ¥ OU AGREE TO BE BOUMND BY
THE TERMS OF THIS AGREEMENT, INCLUDING THE WARRANMTY DISCLAMERS,
LIMITATIONS OF LIABILITY ARD TERMIMATION PROVWISIONS BELCWY. IF Y OU DO MOT
AGREE TO THE TERMS OF THIS AGREEMENT DO MOT INSTALL OR USE THE
SOFTYWARE APPLICATION AMND EXIT MO,

[ |

¥ I accept the terms in the License Agreement

Prink Back. I Mext I Zancel |
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4. Click Next. The Destination Folder screen is displayed.

ii.‘-!;I- Bluespring BPM Admin 5 Setup =10 ]

Destination Folder
Click Mext to install to the default folder or dick Change to choose another,

Install Bluespring BPM Admin 5 to:

IC:'nProgram Files\Bluespring BPM 51,

Change... |

Back I Next I Cancel |

Note: If you want to choose a different destination folder, click Change and select the
folder where you want to store the BPM Admin files.

5. Click Next. The Ready to Install Bluespring BPM Admin 5 screen is displayed.

ii.‘-!;I- Bluespring BPM Admin 5 Setup =10 ]

Ready to install Bluespring BPM Admin 5

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I Install I Cancel
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6. Click Install. The installation begins. When complete, the Completed the Bluespring BPM Admin
5 Setup Wizard screen is displayed.
iz Bluespring BPM Admin 5 Setup o ] oA |

Completed the Bluespring BPM Admin 5
Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish I CACE|

7. Click Finish. You installed the BPM Admin 5.

Verifying the BPM Admin 5 Installation
Verify that the installation was successful by opening BPM Admin 5.

1. From the Start menu, click All Programs. The All Programs menu is displayed.
2. Click Bluespring BPM 5. The list of installed BPM 5 applications is displayed.
3. Click BPM Admin 5. BPM Admin 5 opens.

You successfully completed the installation of Bluespring BPMs.

Note: In order to save your Workspace in BPM Admin, create a console with the Bluespring
Admin Snap-in. Please see Appendix D for further instructions.
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Appendix A

Security Note: Windows Server 2008 User Account Control

You may see a User Account Control window may appear when installing on Server 2008. If you do not
see the window, then your IT department has disabled this feature and you can ignore this section.

User Account Control windows are meant to provide additional security for Microsoft Windows. Prior to
changes being made to your computer, an unauthorized application must receive authorization to do so.
In order to proceed with installation, you must click Yes to authorize the application.

A User Account Control window may resemble the image below:

“e! User Account Control e

.’ii. Do you want to allow the following pregram from an
“24 unknown publisher to make changes to this computer?

Frograsm name  updater, e

Publizher: Uini o
File origire Hard drive an this computer
| Show getails Yes

Shange when these notifications apoea

33 aap
._: J realizingthe PowerofProcess
70 ) people and systems at work



bluespring

SOFTWARE

Appendix B: Windows Firewall and SQL Server Configuration

Bluespring recommends the service and applications be installed on one server and the workspace and
runtime databases be installed on another server dedicated to hosting Microsoft SQL Server. Because
the services and applications will be installed on a separate server, you will need to confirm the
following Windows Firewall and SQL Server settings are correct:

=  Open TCP port 1433 in Windows Firewall on the Microsoft SQL Server
=  Open TCP port 9000 in Windows Firewall on Bluespring Server(s)

= Start SQL Browser Service on SQL Server

= Enable TCP/IP in SQL Server Configuration Manager

Opening TCP Port 1433 in Windows Firewall on the Microsoft SQL Server

For BPM Designer, BPM Admin, and the services to access the database from the remote computer or
server, TCP port 1433 needs to be open in Windows Firewall on Server 2008. By default, Windows
Firewall blocks this port, which is SQL Server’s default port for accepting connection. The port number
can be changed, so confirm with your database administrators that the port number being used is 1433
or note the port being used by the database.

If the SQL and BPM; services and applications are on one server then you do not need to open the port,
because all of the communication between the components happens behind the computer’s firewall.

To open the TCP port 1433 in Windows Firewall on Server 2008, complete the following steps:

From the Start menu, click Control Panel.
Click System and Security.
Click Windows Firewall. The Windows Firewall screen is displayed.

el

Click Advanced Settings. The Windows Firewall with Advanced Security window opens.
il

Fle Acton View Help
A EIE I

W Vindons Fenal vt Advanied S |
3 InbeundRules B —

B3 Outbound Rules [
%4 Connection Security Rules = £ W MewRule...
% Moritoring 1@ windows Collaboration Computer Name Regi... Windows Collsboration Compu... Al Ho
1@ windows Collaboration Computer Name Regi... Windows Collsboration Compu...  All Mo T Filter by Profile >
1@ windows Firewall Remote Mansgement (RPC)  Windows Firewal Remote Man...  Privat... Mo 7 Fiter by State »
(@ windows Firewall Remote Mansgement (RPC)  Windows Firewal Remote Man... Doman Mo
Y Filter by Group »
1@ vindows Firewal Remote Management (RPC... Windows Firewal Remote Man... Privat... Mo
1@ windows Firewal Remote Management (RPC... Windows Firewal Remote Man... Domain Mo View »
@ vindows (ASy... Windows Instru... Domain Mo
6] Refresh
@ vindows (ASy... Windows Instru.. Privat.. Mo &
@ windons (OC... Windows Instru...  Privat.. MNo = Exportlist...
@ vindows OC... Windows Instru... Doman  No d rep
@ windows (WM... Windows Instru... Doman  No
Bicions (it windons et Pt e —
@ windows Media Player (UDP-In) Windows Media Player Al Mo
@ Disable Ruie
1@ windows Media Player Network Sharing Serv... Windows Media Player Networ... Privat... Mo

1@ windows Media Player Network Sharing Serv... Windows Media Player Networ... Domain Mo & cut

1@ windows Media Player Network Sharing Serv... Windows Media Player Networ... Domai... Mo B o

@ windows Media Player Network Sharing Serv... Windows Media Player Netw Domain  No J el Coy
X Delete

(@ Windows Media Player Network Sharing Serv... Windows Media Player Netw
(@ Windows Media Player Network Sharing Serv... Windows Media Player Networ... Domain  No ] Propertiss
(@ Windows Media Player Network Sharing Serv... Windows Media Player Networ... Privat... No
Windrwe Meria Dlaver Nehanrl Sharins Seru Whindsws Media Blaver Networ 81 Nn hd | 7S
<| | il i o

|Deletes the current selection. | [

5. Click Inbound Rules. The Inbound Rules are displayed in the center pane.
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From the Actions on the right-side of the window, click the New Rule. The New Inbound Rule
Wizard window is displayed.

On the Rule Type tab, select the Port option, and then click Next. The Protocol and Ports tab is
displayed.

Confirm the TCP option is selected. If not selected, select TCP instead of UDP.

In the specific port field type 1433, and then click Next. The options for the Action tab are
displayed.

Confirm the Allow the connection option is selected. If not selected, select that option.

Click Next. The Profile tab is displayed.

Click Next. The Name tab is displayed.

In the Name field type SQL Server. The Description is optional.

Once you are finished typing the Name and, optionally, the Description, click Finish. You opened
the TCP port 1433.

Opening TCP port 9000 in Windows Firewall on Bluespring Server(s)

By default, the BPM; service installs assume you want to install them to port 9000. You should only
change this option if the port is taken by another application; however, Bluespring also recommends
each server be dedicated to BPM; for optimal processing. If the port is blocked, which it is by default,
then you will not be able to communicate with the Bluespring BPM; Services from a remote computer.

If all of the BPM; services and applications are on one server then you do not need to open the port,

because all of the communication between the components happens behind the firewall.

To open TCP port 9000 in Windows Firewall on Server 2008, complete the following steps:

el

From the Start menu, click Control Panel.

Click System and Security.

Click Windows Firewall. The Windows Firewall screen is displayed.

Click Advanced Settings. The Windows Firewall with Advanced Security window opens.

i
g
g _
Gutbound Rules
25, Connection Security Rules W3 NewRule.
¥, wonioring o T Filter by Profie »
= T Filter by State »
:: T Filter by Group 4
S microsoft Office Communicator 2007 public  Yes view »
(@ Microsoft Office Communicator 2007 Domain ~ Yes —
I Microsoft Office Communicator 2007 Demain  Yes =
Microsoft Office Communicator 2007 Public Yes |z Exportlist...
(@ Microsoft Office OneNote Domain  Yes H e
Microsoft Office OneNote Domain ~ Yes
(@ Microsoft Office Outiook Domain ~ Yes Buesprng 4|
©sip Client Public  Yes
Sip Client Public  Yes @ Disable Rule
@ sip client Domai... Yes & cut
@ sin Client Domal... Yes .
Skype Al Yes L% ey,
@sa Al Yes K Delete
@saL server Al Yes [ Fropertes
1@ BranchCache Content Retrie: \(H'ITFI ) BranchCache - Content Retrie... Al No
. Branchrache - Hosted Cache al - ~I| @ rep
N
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Click Inbound Rules. The Inbound Rules are displayed in the center pane.

From the Actions on the right-side of the window, click New Rule. The New Inbound Rule
Wizard window opens.

On the Rule Type tab, select the Port option, and then click Next. The Protocol and Ports tab is
displayed.

Confirm the TCP option is selected. If not selected, select TCP instead of UDP.

In the specific port field type 9000, and then click Next. The options for the Action tab are
displayed.

Confirm the Allow the connection option is selected. If not selected, select that option.

Click Next. The Profile tab is displayed.

Click Next. The Name tab is displayed.

In the Name field type Bluespring. The Description is optional.

Once you are finished typing the Name and, optionally, the Description, click Finish. You opened
the TCP port 9000.

Starting SQL Server Browser Service on SQL Server

When you start the SQL Server Browser, it supplies client computers with SQL Server connection
information and is required when the Bluespring services and applications are not hosted on the SQL

Server.

To start the SQL Server Browser service, complete the following steps:

1.

On your SQL Server hosting the workspace and runtime databases, open Services.

Note: One way to open Services is to go to Windows Start > Control Panel > System
and Security > Administrative Tools > Services.

=TT

Eile Action \iew Help

e |mEk=HmRlr a0

C, Services (Local)

Description:

%, Extended

£} Services (Local)

SQL Server Browser

Stop the service
Pause the service
Restart the service

Provides SQL Server connection
information to dient computers,

Name

IDesc.‘. - |Siams

| Startup Type

ILogOnﬂs I

+ Protected Storage
« Credential Manager
£, 5PP Motification Ser...

i, Application Layer G...
TCR/IP NetBIOS He...
" Secure Socket Tun...

Provides pr...

Provides s...
Provides ...

Provides s...
Provides s...
Provides ...

Started

Manual
Manual
Manual
Automatic
Automatic
Manual
Automatic
Manual

Local System
Local System
Local Service

Network 5.
Local Service
Local Service
Local Service

Standard /

Right-click SQL Server Browser. A drop-down list will be displayed.
From the drop-down list select Start. The SQL Server Browser service is now started.
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Enabling TCP/IP in SQL Server Configuration Manager

Finally, you will need to enable TCP/IP for the SQL Server instance hosting the workspace and runtime
databases. This feature is required when the Bluespring services and applications are not hosted—as

recommended—on the SQL Server.

To enable TCP/IP in SQL Server Configuration Manager, complete the following steps:

From the Start menu, click Microsoft SQL Server 2008 R2.

Note: Similar steps apply for Microsoft SQL Server 2005 and Microsoft SQL Server
2008.

Click Configuration Tools.
Click SQL Server Configuration Manager. The SQL Server Configuration Manager window opens.

= 5ql Server Configuration Manager =] E3
Eile Action ¥esw Help
EYEIEEEIL
@ 5L Server Configuration Manager (Local) Protacol Hame | Skatus |
SQL Server Services Y shared Memary Enabled
3 501 Server Nstwork Configuration (32bit) | = Hamed Pipes Enabled
& 5L Mative Client 10.0 Configuration (32bit) | | = 1cpyie Enablsd
= 4. SQL Server Netwark Configuration FvIa Disabled
Proto VER

Frotocols for SHAREPOIMT
&b 5QL Native Clieni 10,0 Corfiguration

| |
Expand the SQL Server Network Configuration. A list of SQL Server instances is listed.

Click the Protocols for <Bluespring Instance> where <Bluespring Instance> is the SQL Server
instance hosting your workspace and runtime databases. The protocols for that instance are
displayed to the right.

Note: For SQL Server 2005, you need to expand the SQL Server 2005 Network
Configuration.
Note: In the above screenshot the instance is called MSSQLSERVER.

Right-click the TCP/IP protocol, and then click Enable. The following Warning window will
appear telling you that you will need to restart the SQL Server service.

Warning

p . | Any changes made will be saved; however, they wil not take
W effect until the service is stopped and restarted,

Click OK. You enabled the TCP/IP protocol and now need to restart the SQL Server service for
the change to become active.

Click SQL Server Services.

Right-click the SQL Server (<Bluespring Instance>) where <Bluespring Instance> is the SQL
Server instance hosting your workspace and runtime database.
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10. Click Restart. The service restarts and the TCP/IP protocol change is not active.

You completed the necessary server changes to allow the Bluespring services and applications to
connect to a remote SQL Server.
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Appendix C: Notification Test Mode

The Notification Service supports a “test mode” option, which can be helpful when you do not want to
send emails to process participants until the solution is published to your production runtime
environment. When enabled, the service sends emails to a comma-delimited set of email addresses set
in the service’s configuration file—not the values configured in the Send Email activity and Notification
Messages.

You will know an email was sent using test mode, because the email contains a special header and
footer. The header section displays the email addresses of the recipients that would have received the
email had test mode been disabled. And the footer simply says Test.

Since test mode is enabled at the service level, the change applies to all emails sent by a specific service
associated with a runtime environment.

IMPORTANT:
When you upgrade the Notification Service or reinstall the service, the
Bluespring.NotificationService.exe.Config file is replaced with a new file. If you want the
upgraded/reinstalled service to use test mode, then you will need to complete the
Enabling Notification Test Mode steps again.

Enabling Notification Test Mode

1. Locate the Bluespring.NotificationService.exe.Config file on the server hosting the Notification
Service.

Note: By default, this file is located in C:\Program Files\Bluespring BPM 5\Notification.

2. Open the file in a text editor.
3. Locate the bluespring.notificationservice section in the XML, which will look similar to the
following:

<bluespring.notificationservice>
<administration url="http://localhost:9000/Bluespring" />
<environment name="bpm5runtime" />
<workspace serverName="localhost" port="9000" protocol="http" securityMode="Windows" />
<testmode enabled="false" recipients=""/>
</bluespring.notificationservice>

4. Setthe testmode element’s enabled attribute to true.

Note: By default, enabled is set to false.

5. Inthe recipients attribute value, enter the email address or email addresses of the test
recipients. When finished, your testmode element will look similar to the following:
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<testmode enabled="true"
recipients="john @bluespringsoftware.com, jane@bluespringsoftware.com” />

Note: Separate multiple email addresses with a comma. A semi-colon will cause the service to
throw an error while sending the email.

6. Save the text file.
7. Restart the Notification Service to activate the new settings. You enabled the Notification Test Mode.

Disabling Notification Test Mode

Disabling the Notification Test Mode will allow the process to utilize the attributes provided in the
process. The notifications will no longer rely on the email addresses provided in the notification text file
but those provided in the processes and their activities.

1. Locate the Bluespring.NotificationService.exe.Config file on the server hosting the Notification
Service.

Note: By default, this file is located in C:\Program Files\Bluespring BPM 5\Notification.

Open the file in a text editor.
Locate the bluespring.notificationservice section in the XML, which will look similar to the
following:

<bluespring.notificationservice>
<administration url="http://localhost:9000/Bluespring" />
<environment name="bpm5runtime" />
<workspace serverName="localhost" port="9000" protocol="http" securityMode="Windows" />
<testmode enabled="true" recipients="john@bluespringsoftware.com"/>
</bluespring.notificationservice>

4. Set the testmode element’s enabled attribute to false.

Note: You do not have to delete the email addresses in the recipients attribute value.

5. Save the text file.
Restart the Notification Service to activate the new settings. You disabled the Notification Test
Mode.
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Appendix D: Creating a Console with the Bluespring Admin Snap-in

Creating a custom console with the Bluespring BPM Admin snap-in will allow you to manage common

Windows and Bluespring features from a single interface. Additionally, the Bluespring BPM Admin added

to your custom console will remember the workspace, so you do not have to enter the workspace each

time you open the console.

A

0 N o w

11.
12.
13.
14.

15.
16.
17.

Click Window Start > Run. The Run window is displayed.

Type MMC in the Open field.

Click OK. The new console window is displayed.

From the File menu, click Add/Remove Snap-in from the drop-down list. The Add or Remove
Snap-ins window is displayed.

Select Bluespring BPM Admin from the Available Snap-ins field.

Click Add. The Workspace Connection window is displayed.

Type the name of the server hosting your workspace in the Workspace server name field.
Type the appropriate port number in the Port field.

Select HTTP or HTTPS from the Protocol field.

Note: Choose HTTPS, if they require secure connections

. Click OK. You added the Bluespring BPM Admin snap-in to the console.

Note: If you want to extend the options on the console, Bluespring recommends adding the
Event Viewer and Server Manager snap-ins. The Event Viewer allows you to view the event logs
for the Bluespring services and the standard Windows logs. The Server Manager is
recommended, because it provides access to the Message Queues and other features installed
on this server.

Click OK.

From the File menu, click Options. The Options window is displayed.

Type the new name in the Console field.

From the Console mode field, select User mode - full access to prevent a reoccurring window
that will prompt you to save.

Select the Do not save changes to this console check box.

Click OK.

From the File menu, click Save. The Save As window is displayed.
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18. Save the console to the location of your choice. You created a console that uses the Bluespring
BPM Admin snap-in.
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Appendix E: Activating your copy of BPM Designer

Bluespring Software will provide you with one of two types of licenses, Trial or Full. With the Trial
license, you will have a designated number of days to use the software before the license expires. The
trial period starts when the license is activated and the license cannot be used again once activated.

You can activate BPM Designer via the Internet or the activation website.

Activating through the Internet
To activate the BPM Designer Licensing, complete the following steps:

1. Open BPM Designer. The Activate BPM Designer 5.1 window is displayed when one of the
following conditions is true:
a. You open BPM Designer on your computer for the first time.
b. You have been using a Trial license and you decide to activate Designer with a Full
license.
c. Your license file is invalid.
2. Inthe User ID field, enter the User ID from the license you received from Bluespring. The User ID
will be a series of numbers (Example: 1234).
3. Inthe Password field, enter the password associated with the User ID you received from
Bluespring.

Note: By default, the | want to activate the software over the internet option is selected.

4. Click Next. The activation status page is displayed.
5. Click Register Now to register your copy of BPM Designer. The Registration Information window
is displayed.

Note: Registration is optional. If you do not want to register your copy of BPM Designer, skip to
step 8.

6. Type the appropriate information into the corresponding fields.

7. Click Register. The Registration window is displayed, notifying you that the registration is
complete.

8. Click OK to close the Registration window.

9. Click Close in the Activate BPM Designer window. BPM Designer automatically opens. You
successfully activated BPM Designer through the internet.

Activating through the Activation Website
To activate the software through the activation website, complete the following steps:

1. Open BPM Designer. The Activate BPM Designer 5.1 window is displayed when one of the
following conditions is true:
a. You open BPM Designer on your computer for the first time.
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b. You have been using a Trial License and you decide to activate Designer with a Full
License.
c. Your license file is invalid.
Type the appropriate information into the User ID field, enter the User ID from the license you
received from Bluespring. The User ID will be a series of numbers (Example: 1234).
In the Password field, enter the password associated with the User ID you received from
Bluespring.
Select the | want to activate the software through the activation website option.
Click Next. The Activation Code retrieval steps are displayed.
Complete steps one and two provided on the page

Note: Ensure that your computer as internet access prior to the completion of these steps.

Click the link provided in step three. The website will appear in a new window.

Enter the verification number in the vacant fields of step two on the activation website.

Click Submit. A new page will appear displaying both the verification number entered and the
activation code.

Note: Registration is optional. If you want to register click Register Now in the Activate BPM
Designer 5.0 window.

Once you retrieve the Activation Code from the activation website, enter the code into the
Activate BPM Designer 5.0 window’s vacant fields provided below step four.
Click Next. The activation status page is displayed.

Note: Registration is optional, if you want to register click Register Now in the Activate BPM
Designer 5.0 window.

Click Close. BPM Designer 5 automatically opens. You successfully activated BPM Designer
through the activation website.
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Appendix F: Activating your BPM Process Engine through the Activation Website
To activate your BPM Process Engine through the activation website, complete the following steps:

1. Type the appropriate information into the User ID field, enter the User ID from the license you
received from Bluespring. The User ID will be a series of numbers (Example: 1234).

2. Inthe Password field, enter the password associated with the User ID you received from
Bluespring.

3. Select the | want to activate the software through the activation website option.

4. Click Next. The Activation Code retrieval steps are displayed.

5. Complete steps one and two provided on the page

Note: Ensure that your computer as internet access prior to the completion of these steps.

6. Click the link provided in step three. The website will appear in a new window.

7. Enter the verification number in the vacant fields of step two on the activation website.

8. Click Submit. A new page will appear displaying both the verification number entered and the
activation code.

Note: Registration is optional. If you want to register click Register Now in the Activate BPM5
Process Engine window.

9. Once you retrieve the Activation Code from the activation website, enter the code into the
Activate BPM Designer 5.0 window’s vacant fields provided below step four.

10. Click Next. The activation status page is displayed.

6. Click Close in the Activate BPM5 Process Engine window. You successfully activated BPM5
Process Engine through the internet and now you want to start the service. The Activated
window is displayed.

Activated Eq

Would you like to skark the Process Engine Service now?

7. Click Yes to start the Process Engine Service. You started the Process Engine Service.
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Appendix G: Manual Database Setup for Bluespring BPM5

BPMD5 supports organizations that require databases and SQL accounts be created manually before

executing the BPM5 installs. As documented in this install guide, you can create the accounts while

setting up the Workspace install, and the runtime account can be created automatically with an auto-

generated password during the runtime database install (runtimedb.exe).

If your organization requires that the databases and SQL accounts be created manually, this section

documents the database and user requirements.

To create your BPM5 database objects (databases, roles, schemas, users) manually, complete the

following steps:

1.

6.

Create your Workspace and Runtime databases using your company’s naming conventions.

Note: Common workspace and runtime database names are BluespringWorkspace and
BluespringRuntime, respectively.

Create a database role named bluespring in your Workspace and Runtime database. The role
should grant the receive permission to the QueryNotificationErrorsQueue Queue object.

In your Workspace database, create Workspace user and Client user schemas and set the owner
to dbo temporarily.

Note: Common workspace and client user schema names are BluespringWorkspaceUser and
BluespringClientUser, respectively.

In your Runtime database, create a Runtime user schema and set the owner to dbo temporarily.

Note: A Common runtime user schema name is BluespringRuntimeUser.

Create a Workspace SQL user account in the SQL instance using your company’s naming
conventions (example: BluespringWorkspaceUser) and configure the following User Mappings:
a. Users mapped to this login: Workspace database from step 1 with workspace schema
from step 3 as default schema.
b. Database role membership:
i. bluespring
ii. db_datareader
iii. db_datawriter
iv. db_ddladmin
v. db_owner
vi. db_securityadmin
vii. public
Create a Client SQL user account in the SQL instance using your company’s naming conventions
(example: BluespringClientUser) and configure the following User Mappings:
a. Users mapped to this login: Workspace database from step 1 with client schema from
step 3 as default schema.
b. Database role membership:
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a. bluespring
b. db_datareader
c. db_datawriter
d. public
7. Create a Runtime SQL user account in the SQL instance using your company’s naming
conventions (example: BluespringRuntimeUser) and configure the following User Mappings:
a. Users mapped to this login: Runtime database from step 1 with runtime schema from
step 4 as the default schema.
b. Database role membership:
i. bluespring
ii. db_datareader
iii. db_datawriter
iv. db_owner
v. public

Note: The db_owner role is required if you use the Runtime SQL user with the
runtimedb.exe application.

Example Command:

runtimedb ADD BluespringRuntime -s (local)\BPM5 -cu
BluespringRuntimeUser -cp password -u
BluespringRuntimeUser -p password

8. Inyour Workspace database, update the default owner of the Workspace user and Client user
schemas created in step 3 to the Workspace and Client users created in steps 5 and 6,
respectively.

9. Inyour Runtime database, update the default owner of the Runtime user schema created in
step 4 to the Runtime user created in step 7.

10. Open the properties of your Workspace database and complete the following steps:

a. Onthe Permissions tab, search and add the bluespring role and grant the following
permissions to the role:
i. Create procedure
ii. Create queue
iii. Create service
iv. Execute
v. Select
vi. Subscribe query notifications
vii. View definition
b. On the Options tab, change Recovery model to Full and Broker Enabled to True.
11. Open the properties of your Runtime database and complete the following steps:
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a. Onthe Permissions tab, search and add the bluespring role and grant the following

permissions to the role:

i
ii.
iii.
iv.
V.
vi.
vii.

Create procedure

Create queue

Create service

Execute

Select

Subscribe query notifications
View definition

b. On the Options tab, change Recovery model to Full and Broker Enabled to True.
12. Install Bluespring BPM5 using the databases and SQL accounts created here.

Note: When connecting to the SQL server for the Workspace install, you should be able to
connect and perform the install with the Workspace user created in step 5.

Note: Any runtime database steps need to be repeated for each runtime database you have in your
BPM5 environment.
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